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1. General Description

This user guide is intended to assist the users in evaluating the module by providing instructions on how to
effectively use the evaluation kit.

The BDE-MP2652R7 is a high-performance multiprotocol 2.4GHz wireless module supporting Thread, Zigbee®,
Matter, Bluetooth® 5.2 Low Energy, IEEE 802.15.4g, IPv6-enabled smart objects (6LoWPAN), proprietary systems
including Tl 15.4-Stack (2.4GHz), and concurrent multiprotocol through a Dynamic Multiprotocol Manager (DMM)
driver. For more information on the module, please refer to module datasheet.

The kit includes a breakout board with module (board number: BDE-MB13-BO), a Launchpad™ evaluation
module which can connect with the breakout board through the BoosterPack™ interface (board number: BDE-
LPEM), and also a XDS110 debugger used for debugging BDE-MP2652R7 device (board number: BDE-XDS110).

2. Launchpad Evaluation Module: BDE-LPEM

The BDE-LPEM is an evaluation module designed as an interface module with BoosterPack interface which can
connect with any boards that come with the standard BoosterPack interface, including the BDE-MB13-BO board.
For more details on the BoosterPack pinout standard, please refer to this link.

The board overview is shown as Figure 1.
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Figure 1. Board Overview of BDE-LPEM
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3. Breakout Board: BDE-MB13-BO

We provide a breakout board for module to enable easy access to every exposed pad on module with the
2.54mm-pitch pins. The breakout board can be stacked to the BDE-LPEM board for evaluation.
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Figure 3. The Photo of BDE-LPEM Stacked with the Breakout Board with Module
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3.1.

Breakout Board Header Pin Assignment

Table 1 shows the pin assignment for breakout board header J1, J2, J3 and J4.

Table 1. Breakout Board Headers Pin Assignment

Pin Number | Pin Name Type/Direction | Description

1 3v3 Power Board power supply, connect with module VDD through a ferrite
bead

2 DIO23 I/0 GPIO

3 DIO2 I/0 GPIO, module RX in BoosterPack pin

4 DIO3 I/0 GPIO, module TX in BoosterPack pin

5 DI022 I/0 GPIO

6 DIO024 I/0 GPIO

7 DIO10 I/0 GPIO, SPI_CLK in BoosterPack pin

8 DIO21 I/0 GPIO

9 DI04 I/0 GPIO, 12C_SCL in BoosterPack pin

10 DIO5 I/0 GPIO, 12C_SDA in BoosterPack pin

11 DIO15 I/0 GPIO

12 DIO14 1/O GPIO, Button 2 in BoosterPack pin

13 DIO13 1/O GPIO, Button 1 in BoosterPack pin

14 DIO8 I/0 GPIO, SPI_MISO in BoosterPack pin

15 DIO9 I/0 GPIO, SPI_MOSI in BoosterPack pin

16 nRST Input Reset pin, active low

17 NC - No connect

18 DIO11 I/0 GPIO, SPI_CS in BoosterPack pin

19 DIO12 I/0 GPIO

20 GND GND Board ground

21 NC - No connect

22 GND GND Board ground

23 DIO25 I/0 GPIO

24 DIO26 I/0 GPIO

25 DlO27 I/0 GPIO

26 DIO28 I/0 GPIO

27 DIO29 I/0 GPIO

28 DIO30 I/0 GPIO

29 DIO0 I/0 GPIO

30 DIO1 I/0 GPIO

31 DIO17 I/0 GPIO

32 DIO16 I/0 GPIO

33 TCK - TCK for JTAG/XDS110

34 TMS - TMS for JTAG/XDS110

35 NC - No connect

36 DIO18 I/0 GPIO
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Pin Number | Pin Name Type/Direction | Description

37 DIO19 I/0 GPIO

38 DIO20 I/0 GPIO, PWM/GPIO in BoosterPack pin
39 DIO6 1/O GPIO, RED LED in BoosterPack pin
40 DIO7 1/O GPIO, Green LED in BoosterPack pin

3.2. Debug Header Pin Assignment
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Table 2 shows the pin assignment for the debug header.
Table 2. Debug Header Pin Assignment

Pin Number Pin Name | Type/Direction | Description

1,2,8, 14,20 GND GND Board ground

3 5V Power 5V supply from XDS110

4,6,12,16,18 NC - No connect

5 3v3 Power Module power supply

7 RXD Input Module UART RXD

9 TXD Output Module UART TXD

10 SWO I/0 SWO for JITAG

11 nRST Input Reset pin, active low

13 TMS I/0 TMS for JTAG/XDS110, or SWDIO for SWD debug
15 TCK I/0 TCK for JTAG/XDS110, or SWDCK for SWD debug
17 TDO I/0 TDO for JTAG/XDS110

19 TDI I/0 TDI for JTAG/XDS110

BDE recommends using XDS110 for the debug. J-Link or other debuggers support SWD could also work.

BDE Technology Inc.
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Figure 5. BDE-XDS110
The board can also be connected via a 2x5P 1.27-pitch ribbon cable to the XDS110 debugger.

“firersiEmt e

4. Getting Started

Below section describes how to set up the development environment of BDE-MP2652R7xx module, including the
hardware and software.

4.1. Prerequisites

4.1.1. Hardware

e BDE-MB13-BO, breakout board with module BDE-MP2652R7xx, depending on what module variant you are

BDE Technology Inc. 714 info@bdecomm.com
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choosing;
e BDE-LPEM, Launchpad evaluation interface module;
e BDE-XDS110, XDS110 debugger;
e USB type C cable;
e PC

4.1.2. Software and Tools

e Code Composer Studio
e SIMPLELINK-LOWPOWER-F2-SDK
e SimpleLink Connect mobile app

e UniFlash
e SmartRF Studio
e PuTTtY

4.2. Hardware Setup

1. Plug BDE-MB13-BO into the BDE-LPEM evaluation module and connect BDE-LPEM to BDE-XDS110, as shown

in Figure 6;
2. Connect the jumpers as shown in Figure 6;
3. Connect the BDE-XDS110 to the PC via a USB type C cable. The XDS110 will power the module with 3.3V if the

jumper on BDE-XDS110 is plugged to XDS.

BDE Technology Inc. 8/ 4 info@bdecomm.com
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Figure 6. Hardware Setup

4.3. Software Setup

4.3.1. Download and Install CCS

1. Visit the following link.
https://www.ti.com/tool/CCSTUDIO
2. Find CCSTUDIO item, and click “Download options”.

Downloads

IDE, CONFIGURATION, COMPILER. OR DEBUGGER
—
@ CCSTUDIO — Code Composer Studio™ integrated development environment (IDE)

Supported products & hardware A Notifications

3. Choose the target platform, in this case, Windows is selected.

Downloads  Supported products & hardware

A windows single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 925937 K MDS5 checksum  03bed76dcd6afe5bsbds789c6500d70f Il
& Linux single file (offline) installer for Code Composer Studio IDE (all features,

devices) —1017375K MDS5 checksum  3b85c52574e07f18028b3f406d28d466 [l

l&

macOs single file (offline) installer for Code Composer Studio IDE (all features,
devices) — 1132582 K MDS5 checksum  dda2478¢5250cf79e877c941361772f1 ]

4. Decompress the zip file, and double-click “ccs_setup_xx.exe”.

s

Mame

components
& ccs_setup_20.1.0.00006
timestarnp

5. Click “Next”.

BDE Technology Inc. 9/ 4 info@bdecomm.com
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i Code Composer Studio Setup - X

Code Composer Studio Setup - CCS 20.1.0.00006

Welcome to the CCS 20.7.0.00006 Setup Wizard.

89

code composer™
STUDIO

< Back Cancel

6. Select “l accept the agreement”, and then click “Next”.

§P Code Composer Studio Setup - x
License Agreement n’

Please read the following License Agreement. You must accept the terms of this agreement before continuing with the installation.

TECHNOLOGY SOFIWARE PUBLICLY AVAILRELE

Copyright (c) 201€ Texas Instruments Incorporated
211 rights reserved not granted herzein.
Limited License Agreement.

This Limited License Agreement ("Rgreement™) is a legal agreement between you (either an indiwvidual or
entity) and Texas Instruments Incorporated ("TI"). The "Software" consists of the following materials: (a)
the materials identified as TI proprietary software programs in the software manifest for the software
subject to the terms herein, and any "on-line" or electronic documentation associated with these programs, or
any portion thereof (the "Licensed Materials"), and (b) the materials identified as open source materials or
third party proprietary software in the software manifest for the Software, or any portion thereof ("Public
Software™). For clarificatiom, your use of the Licensed Materials is subject to the licensing terms
contained in this Agreement and your use of the Public Software is subject to the separate licensing terms
specified in the applicable software manifest and/or identified or included with the materials to which they
apply. This Agreement does not limit your rights under, or grant you rights that supersede, the license

Do you accept this license? I
4 3 (O I do not accept the agreement

< Back | Mext > I Cancel

7. Click “Next”.
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§P Code Composer Studio Setup — X

Please read the information carefully to determine if you need to take any action prior to continuing. n?

Operating System Check -> OK

Installer Path Check -> OK

Unicode Character Check -> 0K

Anti-virus Check -> We have detected you are running anti-virus software on this computer. Anti-virus real-time file scanning may interfere with
installation and it is recommended you temporarily disable this feature. Anti-virus software may also block the downloading of files that occurs
during installatien. If you cannot disable the anti-virus software, we recommend the offline installer, which has less interference.

< Back Cancel

8. Choose the installation directory, and then click “Next”.

§P Code Composer Studio Setup — X

Installation Directory ﬁ

Please specify the directory where CCS 20.1.0.00006 will be installed.

Installation Directory

| g

9. Select “Wireless connectivity” components, and then click “Next”.
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&8 Code Composer Studio Setup - x

Select Components

Select the components you want to install; clear the components you do not want to install. Click Next when you are ready to continue,

] MSPMO Arm® Cortex ®-MO+ microcontrollers Click on a component to get a detailed description
] MSP430™ microcontrollers

[ ] C2000™ real-time microcontrollers

L Arm®-based processors

[[] AM2x Arm @-based high perfermance microcontrollers
[ mmWave Sensors

[] Hercules™ Safety MCUs

[ TM4C12x Arm® Cortex @ -Md4F MCUs

[ ceooo Power-Optimized DSP

[] OMAP-L1x DSP + Arm3™ Processor

[] SimpleLink™ MSP432™ low power + performance MCUs
[] PGA Sensor Signal Conditioners

[J uco Digital Power Controllers

< Back Cancel

10. Click “Next”, and the installation will start. Wait until the installation is complete.

G Code Composer Studio Setup — x

Ready to Install

Setup is now ready to begin installing CCS 20.1.0.00006 on your computer.

< Back Cancel

11. Click “Finish”.
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§P Code Composer Studio Setup — X

Completing the CCS 20.1.0.00006 Setup Wizard

Setup has finished installing CCS on your computer,

Create Desktop Shortcut
[ Launch CCS

89

code composer™
SsTUDIO

< Back | Finish | Cancel

4.3.2. Download and Install SDK

1. Visit the following link.
https://www.ti.com/tool/download/SIMPLELINK-LOWPOWER-F2-SDK
2. Find “SIMPLELINK-LOWPOWER-F2-SDK” item, and click “Download options”.

) ) SOFTWARE DEVELOPMENT KIT (SDK)
SIMPLELINK-LOWPOWER-F2-SDK — SimpleLink™ Low Power F2 software -
e development kit (SDK) for the CC13x1, CC13x2, CC13x4, CC26x1, CC26x2 and

CC26x4 devices A Notifications

The SimpleLink™ Low Power SDKs support the CC13xx, CC23xx and CC26xx family of products. Together, these SDKs
provide comprehensive software packages for the development of Sub-1 GHz and 2.4 GHz applications including
support for Bluetooth® Low Energy, Mesh, Zigbee®, Matter, Thread, 802.15.4-based, (...)

Supperted products & hardware

3. Choose the target platform, in this case, Windows is selected.
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Downloads  Supported products & hardware

4 windows Installer for SimpleLink CC13XX CC26XX SDK — 817328 K

Checksum 6bfgbfod0ed1dbedf3ae256f127aeeff ™
& Linux Installer for SimpleLink CC13XX CC26XX SDK — 841416 K

Checksum 9e8c13c6120f4f5f7f0854b7127d824b Fn
A Mac 0S Installer for SimpleLink CC13XX CC26XX SDK — 798418 K

Checksum 2cbf4c3a2e2d703a0d4b5ac3195d14fc I
4 windows Zipfile for SimpleLink CC13XX CC26XX SDK — 1501218 K

Checksum dc5699f56b18e50d4e5f8ddcag0ddede I
+ Mac 0S Zipfile for SimpleLink CC13XX CC26XX SDK — 1578922 K

Checksum 2c5f6183848bc138d31d0db6fa3720ds Fn
A Linux Zipfile for SimpleLink CC13XX CC26XX SDK — 1605828 K

Checksum 1c8f736a65326a65bb39406dd9d1ba77 I

4. Double-click the installation package.
5. Click “Next”.

* Setup — O >

Setup - Simplelink Low Power F2 SDK 8.30.01.01

Welcome to the Simplelink Low Power F2 SDK 2.30.01.01
Setup Wizard.

< Back Cancel

6. Select “l accept the agreement”, and then click “Next”.
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* Setup — O >

License Agreement ”

Please read the following License Agreermnent. You must accept the terms of this
agreement before continuing with the installation.

e
Copyright (c) 2015-2024, Texas Instruments Incorporated
211 rights reserved not granted herein.
Limited License.
Texas Instruments Incorporated grants a world-wide, royvalty—free,
non—-exclusive license under copyrights and patents it now or
herseafter e

I@ ‘| accept the agreement; I

Do you accept this license?
| do not accept the agreement

< Back Mext = Cancel

7. Choose the installation directory, and then click “Next”. Make sure the installation directory does not include
non-ASClI characters or spaces.

* Setup — O >

Installation Directory ”

Please specify the directory where Simplelink Low Power F2 SDE 8.30.01.01 will be installed

The following directories will be created in this directory:

simplelink_ccl3xx_cc2Bxx_sdk_8_30_.01_0
sysconfig_1.21.1
xdctools_3_62_01_15_core

Installation Directory

< Back Mext = Cancel

8. Click “Next”, and the installation will start. Wait until the installation is complete.
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* Setup — O x

Ready to Install ”

Setup is now ready to begin installing SimpleLink Low Power F2 5DK 8.30.01.01 on your
computer,

< Back Cancel

9. Click “Finish”.

Completing the Simplelink Low Power F2 SDK
8.30.01.01 Setup Wizard

INSTRUMENTS

Setup has finished installing SimpleLlink Low Power F2 5DK
8.30,01.01 on your computer,

< Back

4.4. BLES5-STACK

This section describes how to use the BLE5-Stack projects with CCS.

The BLE5-Stack examples are located at
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\ LP_CC2652R7\ble5stack

BDE Technology Inc. 16 | M info@bdecomm.com
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4.4.1. Import Project into CCS

1. Open the CCS IDE.
Go to File -> Open Folder.

Project Run Scripts Terminal Help

Ctril+N
Ctri+Alt+N

New Folder...

Cpen File... Ctrl+0
Open Folder... Ctrl+K, Ctrl+0O

Cpen Workspace from File... Ctrl+Alt+W

Ctri+Alt+R

Ctrl+5S

Ctri+Alt+S

Preferences

[ Exit

3. Select a custom path as the workspace.

» BDE workplace » CC2652R7 » CC2652R7 Userguide v | O

4. Go to File -> Import Project(s).

BDE Technology Inc. 17 1 M info@bdecomm.com
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View Go Project Run Scripts Terminal Help

5 import Project(s

New Text File Ctri+N

Ctri+AR+N

)ser Stu

Ctrl+0
Ctrl+K, Ctrl+O
1+Al+W

Ctri+AR+R

zonnect your board

Ctrl+Alt+S

udio™ IDE

5. Click “Browse”, navigate to the “simple_peripheral” project folder. The default path is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_CC2652R7\ble5stack\simple__
peripheral

6. Select the project, and click “Finish”.

Import Projects

: sdke 8 30_01_01\examplesirtos Browse...

Search directory ~ C:\ti\simplelink_cc13xx_cc26

3 simple_peripheral_LP

Create each projectin: CC2652R7_Userguide w

Open * " to browse and import example projects

Cancel Finish

|ll

7. The “simple_peripheral” project will be imported into the IDE.
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File Edit Selection View Go Project Run Scripts  Terminal

@ EXPLORER

> OPEN EDITORS

~ CC2652R7_USERGUIDE

~ Esimple_peripheral_LP_CC2652R7_tirtos7_ticlang

> B} Generated Source
> B3 application

» B3 common

> B3 Drivers

> B icall

> B icallBLE

> B3 Include

> B3 NPI

> B3 Profiles

> B3 startup

O simple_peripheral.syscfg

4.4.2. Modify XOSC Cap Setting

The “XOSC Cap Array Delta” parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

1. Open “simple_peripheral.syscfg” file by double-click it.
2. Select the ‘Device Configuration’ item. Make sure that the XOSC Cap Array Modification’ checkbox is
unchecked.

Device Configuration 3
Force VDDR O
Enable DCDC
LF X0SC

O

48 MHz XOSC_HF

3. Save the changes.

4.4.3. Build and Download Project

1. Select Project -> Build All to build the application project.
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File Edit Selection WView Go Project Run Terminal Help

Build All

@ EXPLORER mple]
_ uild Project(s) Ctri+B
> OPEN EDITORS

~ OC2652R7T_USERGUIDE

~

= Properties... Alt+Enter

DMM
MCUboot
Device Configur.. 1/1

RF Design

File Edit Selection Wiew Go Project Run Scripts Terminal Help
EXPLORER Debug Project (simple_per..)

N ] Flash Project (simple_per..) Ctrl+F5
» OPEN EDITORS

Start Debugging
\ (C2652R7_USERGUIDE EI L 5

> B3 common
> B3 Drivers
> B3 icall

> B3 icallBLE
> B3 Include
> B3 NPI

> B3 Profiles

README.html

e_peripher

(If you are using CCS 20.1.0, the following error may occur during the debugging process. Execute thefollowing
steps to fix it.

Command=28 -- addr-2x@e888808 -- length-2x00a888H8

Browse to <CCS 20.1.0 INSTALL DIR>\ccs\ccs_base\emulation\drivers
Backup or rename the "tixds510cortexM33.dvr" file in the directory

Extract the file in the zip below in the above location
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tixds510cortexM33.zip
Try CCS again and see if the issue is resolved.)

4.4.4. Running the Demo

1. Open PuTTY, open the serial port with the following settings:

&2 PuTTY Configuration ? >
Category:
=l Sgassiu:un Basic options for your PuTTY session
- Ten I..Dglging Specify the destination you want to connectin
=} Terminal —
- Keyboard Serial line Speed
- Bel \comi11] | 115200
- Features Lonnectiop fype:
=+ Window OssH | @ Senal |O0ther: | Telnet v
- Appearance
- Behaviour Load, save or delete a stored session
- Translation Saved Sessions
- Selection | |
i Colours
-I- Connection Load
i Data
- Praxy Save
P- 55H
H . Delete
----- Serial
----- Telnet
Rlogin
L SUPDUP Close window on exit:
(O Mways () Mever (@) Only on clean exit
About Help COpen Cancel

The COM number can be found in the System Device Manager:

i XDS110 Class Application/User UART (COM111)
ALSTITU Ulass Awahary Lrata Fort (LURNTTL]

2. Debug the project and click “Continue” in CCS. The demo will begin execution. The PuTTY will display the
menu as shown below:

3. Open SimpleLink Connect mobile app. Click “Enable BluetoothLE Scan”, and you will see that the module is
advertising.
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Enable BluetoothLE Scan

W,

Available devices: 38

@ Advertising =

4 Basic BLE project

( -2 >
ID: AZDBAZ26D-DDD7-7C5D-5F26-FCASS05AB379 -ll

@ Advertising =

4. Click the right arrow on the right of “Simple Peripheral”
connection, you will see PUTTY update the information.

n.ii'_rr.l: le Peripheral

item to connect to the module. After a successful

+Work wi

5. Select “TI Simple Peripheral Service”.

Available services: 2

Device Information

- Tl Simple Peripheral Service
OxFFFO )

dlaCLer=LICS

6. Enable the notification of “Characteristic 4”, the app will receive notification sent by the module.
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Characteristic 4
UUID: OxFFF4

Praperties: Notify

Motifications Enable O

03

7. Write “05” to “Characteristic 3”. PUTTY will print the write information.

Characteristic 3
UUID: OxFFF3

Properties: Write

Write

05

4.5. Host_test Project & Btool Software

Tl provides a PC tool called “btool” to help developers simplify development. Developers can use Btool to scan
and connect to peripheral devices, or to send raw HCl commands.

The directory for Btool is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\tools\ble5stack\btool.

Before using Btool, the module must have the host_test application flashed onto it first.

The project directory for host_test is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\LP_EM_CC2652R7\ble5stack\host_test.

Before building the host_test project, developers should perform the additional steps mentioned in sections 4.4.2.

The module will enter DTM mode once the host_test application is flashed. Btool can connect to the module
through UART interface.

The pins used by UART can be found in the following diagram:
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Global Parameters  Settings that affect all instances
UART2 (1 Added) &
CONFIG_DISPLAY_UART

CONFIG_DISPLAY_UART

®
@

(€]

Send and Receive

fority

RF Design

Board
Displa

par RX Interrupt FIFO Th
DMA

PinMux  Peripheral and Pin Configuration

UART Peripheral

TXPin 10 UART))
RX Pin (1 10 UART))

The following steps demonstrate how to operate Btool.
1. Open Btool.
2. Open the serial port with the following settings, and make sure the correct port is selected.

®p Serial Port Settings e
Port: | COMIT1 w
Baud: | 115200 ~
Flaw: | None o
Party: | Mone w
Stop Bits: | One e
Data Bits: |8 w

3. If the hardware functions properly, the following UART logs will be printed.
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[1] : <Info> — 02:40:25_158
Fort opened at 2024/10/22 14:40:25

2] : «T=>» — 02:40:25.237
-Tyvpe : 0201l (Command)
—CplCode : OxFC1D (HCIExt ResetSystemCmd)
—-Data Length : 0xd1 (1) byte(s)

Type o 0=dd (0) (Chip Reset)
Duamp {Tx) =
QoQo:Ql 1D FC OL QO .
[3] : <Rx> - 0Z2:40:25.3584

-Type : 0xd4 (Ewvent)

—EventCode : Ox00FF (HCI_LE ExtEvent)

-Data Length : 0xd5 (5) bytes(s)

Event : 0x041D (1053) (HCIExt ResetSystemCmdDone)
Status : 0x00 ({0) (SUCCESS)

CmdCpCode : OxFC1D (HCIExt ResetSystemilmd)

Dump (Rx) -

QoQo:04 FF O5 1D O4 QO 1DFPC ..

[4] : <Tx= — 02:40:25.903
-Type : 0x01l (Command)
—OpCode : OxFEOO (GAFP_Devicelnit)
-Data Length  0x02 (2) byte(s)

ProfileRole - 0x08 (8) |

Central)

2ddrMode : 0x00 (0) (RDDRMODE_PUBLIC)

Randomiddr = 00:00:00:-00:-00:00
Cump {Tx) -

Q0ad:01 00 FE 08 48 00 90 Qo0 00 00 0O 0O L Liio...
[5] : <Rx> - 0Z:40:25_%30

-Type o Ox04 (Event)

—EwventCode : O0x00FF (HCI_LE ExtEvent)

—-Data Length : 0xd€ (€) bytes(s)

Event : Ox0€7F (1€€3) (GAP HCI ExtentionCommandStatus)
Status : Q=00 (0} (SUCCESS)

4. Developers can scan for and connect to peripheral devices on the “Discover Connect” page.

Select Device Operation @ comi1t
Di
Read Write -~
Pairing Bonding .
Advanced Commands Raad lIl B
Over The Air Download B Ford 0 Max Records:
Scan Scan & Connect Cancel
Connection Settings
ocoMi Min Connection Interval (6-3200): 8015 (100.00ms)
o Pott Info ) -
£ Device Info: Mazx Connection Interval (6-3200): 8013 (100.00ms)
-Handle: DxFFFE Peripheral Latency (0-453): =

-BDAddr: 34:68:B5:2C:96:34 Supervision Timeout (10-3200;: | 2000/ (20000ms)

O ProfileRole:
“Central
Load Settings Get Set
Link Control
Establish Link
Pesrrd 0
Establish Cancel
Link Options

Connection Handle: | (xFFFE PHY Teminate

5. The “Advanced Commands” page provides a variety of HCl commands. For example, developers can send
“HCI_LE_Transmitter_Test” command in the following diagram.
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Select Device Operation

¥ comn

Discover Connect
Read Write
Pairing Bonding

Advanced Commands
Over The Air Download

Pt Info
& Device Info:
Handle: OFFFE

BDAddr: 34:68:B5:2C:56:34

© ProfileRole:
+Central

4.6. TI154STACK

-GATT
GAP

- GAPBondMar
GAP AE

- Ll

=-HCl

~ HCI_Reset
HCI_ReadLocalSupportedFeatures

- HCI_ReadBdAddr
HCI_ReadRSSI

~ HCI_LE_ReadLocalSupportedFeatures
HCI_LE_ReadWhiteListSize

~ HCI_LE_ClearWhiteList
HCI_LE_AddDevice ToWhite List

~ HCI_LE_Remove DeviceFromWhiteList
HCI_LE_ConnectionUpdate

~ HCI_LE_Long TermKeyRequestedReply
HCI_LE_LongTermKeyRequestedNegative Reply

- HCI_LE_ReceiverTest

estl
HCI_LE_RemoteConnectionParameterRequest Reply
~ HCI_LE_RemateConnectionParameterRequestNegative Reply
HCI_LE_SetDatalength
~ HCI_LE_SetResolvablePrivate Address Timeout
HCI_LE_ReadMaxDatalength
- HCI_LE_ReadPhy
HCI LE SetDefaultPhy

oplode ZUTE
txChanne! 0
testDatalength 0
testData 00

opCode
HCI_LE_Transmitter Test

Send Command

TI” sroyalty-free Tl 15.4-Stack is a complete software platform for developing applications that require extremely
low-power, long-range, reliable, robust and secure wireless star-topology-based networking solutions. This
section describes how to use the Tl 15.4-Stack projects with CCS.

To demonstrate the Tl 15.4-Stack demos, two modules are required.

4.6.1.

1.
2.

Open the CCS IDE.
Go to File -> Open Folder.

Import Projects into CCS
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D)5

File Edit Selection View Go Project Run Scripts Terminal

@ ES Create New Pro

5 Import Project(

New Text File Ctri+N

New File... Ctri+Alt+N

Cpen File... Ctrl+0
Open Folder... Ctrl+K, Ctrl+0O
ile.. Ctri+Alt+W

Ctri+Alt+R

[ Exit

3. Select a custom path as the workspace.

» BDE_workplace » CC2652R7 » CC2652R7_Userguide

4. Go to File -> Import Project(s).

Help

File | Edit Selection View Go Project Run Scripts Terminal Help

ES Create New Project...
E5 Import Project(s)...
MNew Text File

MNew File Cti

™ yser Stu

Open File...
Ctrl+K, Ctr+O
Ctri+Alt+wW

Ctrl+Alt+R

ronnect your board

Ctrl+5S

Ctrl+Alt+S

Preferences > udio™ IDE

[ Exit

5. Click “Browse”, navigate to the til54stack folder. The default path is:

C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\LP_CC2652R7\ti154stack.
6. Select “collector_LP_CC2652R7_tirtos7_ticlang” and “sensor_LP_CC2652R7_tirtos7_ticlang” projects, then
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click “Finish”.

Import Projects

Search directory  C\ti\simplelink_c cc26xx_sdk_8_30_01_0T\examples\rtos\ Browse...

vered projects

C2

Create each project in: CC2652R7_Userguide v

Open* * to browse and import example projects

Cancel Finish

7. The two projects will be imported into the IDE.
File Edit 5 View Go Project Run
EXPLORER ---

> OPEM EDIT... SEnsor irtos7_ticlang

v CC2652RT7.... theia
v B collector collector_LP_CC2652R7 _tirtos7_ticlang

% Fl.Genera ~ sensor_LP_CC2652R7_tirtos7_ticlang

4.6.2. Modify XOSC Cap Setting

The XOSC Cap Array Delta’ parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

1. Open “collector.syscfg” file by double-click it.
Select the ‘Device Configuration’ item. Make sure that the XOSC Cap Array Modification’ checkbox is
unchecked.
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&« = Software » Device Configuration

Device Configuratio

Force VDDR
Enable DCDC
k Source

Cap Amray Modification
HF Clock Source
RF Temperature Compensation
RTC X0SC LF Compensation
Enable Bootloader
Enable Bootloader Bac

Bootloader Backdoor DIO

2. Save the changes.
1. Similarly, modify XOSC Cap Setting in sensor.syscfg.

4.6.3. Build and Download Project

1. Select Project -> Build All in the toolbar menu. Both the “collect” and “sensor” projects will be built.

File Edit Selection View Go Project Run Scripts Terminal Help
Build All
Build Project(s) Ctri+B

EXPLORER

> OPEN EDITORS
- Clean Project(:
~ OC2652R7T_USERGUIDE
: tebuild Projec
v Elcollector_LP_CC2652R7 tirtos  Repild Proj
> El,Generated Source Build Configurations
System Configurations

Executable Actions

» B software stack
» B3 targetConfigs > Properties... Alt+Enter

d.html
tirtos7.cmd

O collector

2. Select the “collector” project as the current active project by clicking the “collector” project root directory
in the “Project Explorer” view.
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File Edit Selection View Go Project Run Scripts Terminal Help

@ EXPLORER

» OPEN EDITORS

~ (0C2652R7_USERGUIDE BEBELS -
~ Pl collector_LP_CC2652R7_tirtos7_ticlang [Release]

> B3 Generated Source

"_tirtos7.cmd

3.

Debug Target 0 - TIXDS110_Connection
Seral Number : XDSD0009

4.

XD5110 USE Debug Probeyt

quired for the XDS11( rrent firmware is
he probe must be upgraded to firmware version 3.0
with this software. Click

Cancel Update

5. After the update process is finished, click “Continue”.

DEBUG

6. Select the “sensor” project as the current active project by clicking the “sensor” project root directory in the
“Project Explorer” view.
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~ Fl.sensor_LP_CC2652R7_tirtos7_ticlang [Release]

» B3 Generated Source

> B3 application
> BGsRelease
» B sofiware_stack

2x7_tirtos7.cmd
README. htm
README.md

SeNsor.syschig

7. Select Run -> Debug to download the “sensor” application to the other module.

Debug Target 0 - TIXDS110_Connection
Serial Number : XDS00009

Debug Target 1 - TIXDS110_Connection

35110_Connection

Debug Target 1 - TIXDS110_Connection

4.6.4. Running the demo

1. Opentwo instances of PuUTTY. Open the correct serial ports separately using the following settings.
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BDE

&2 PuTTY Configuration

Category:

—|- Session

=} Terminal

- Keyboard
- Bell

- Features
=1 Window

- Appearance
- Behaviour
- Translation
+- Selection
i Colours

—I- Connection

.. Data

- Prowy

+- S5H

- Serial

- Telnet

- Rlogin

- SLIPDLUP

About

Help

Basic options for your PUTTY session

Specify the destination you want to conne

io

Senal line Speed

[comit1] Il 115200

Lonnectiop IyDe,

(185H | (@) Seral | () Cther: | Telnet

Load. save or delete a stored session

Saved Sessions

Load
Save
Delete

Close window on exit:
() Mlways

(") Never

(®) Only on clean exit

Open

Cancel

The COM number can be found in the System Device Manager:

2. Resetthe two modules by pressing the reset button on the BDE-XDS110 board. PuTTY will display the menu.

3. On the collector terminal side, press the right arrow key on the keyboard twice to switch to the “NETWORK

ACTIONS” menu.

i XDS5110 Class Application/User UART (COM111)

AUSTID Llass Awaliary Uata Port (LUNTTE)

4. Press the enter key on the keyboard to open the “NETWORK ACTIONS” menu.
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5. The “NETWORK ACTIONS” menu has three actions: “FORM NWK"”, “OPEN NWK"”, “CLOSE NWK". You can
switch between these actions by pressing the left/right arrow keys.

6. Switch to “FORM NWK?”, then press the Enter key to form a Tl 15.4 network. By default, the network forbids
other devices from joining.

7. Switch to “OPEN NWK”, then press the Enter key to allow devices to join. At this time, the red LED on the
collector board will blink.

8. On the sensor terminal side, open the “NETWORK ACTIONS” menu and perform the “ASSOCIATE” action.
After a while, the sensor will join the network created by the collector. The red LED on the sensor board will
turn on.

9. On the collector terminal side, press the Esc key to retun to the root menu, then switch to the “APP” menu
and perform the “SEND TOGGLE” action. The red LED on the sensor board will toggle.
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4.7. Use UniFlash to Download Firmware

In the section above, the method to flash the firmware is through debugging in the CCS IDE.

Tl provides a software tool called UniFlash, which can be used for programming on-chip flash on TI
microcontrollers and wireless connectivity devices.

4.7.1. Configure UniFlash

1. Open UniFlash.
2. Select ‘CC2652R7".

+ New Configuration

@ Choose Your Device

Category: All | C2000 | mmWave | MSP | PGA | Safety | Tiva | UCD | Wireless | Bootloader

Q, CC2652R7| Ix
& LP-CC2652R7 LaunchPad On-Chip
¥ coiosar7 On-Chip

3. Select “Texas Instruments XDS110 USB Debug Probe”, then click the “Start” button.

~ New Configuration

@ selected Device €C1354P10

0 Selected Connection: w Texas Instruments XDS110 USB Debug Probe

BT CRITaWR AT SO0V Z-USE Sy STENT TTaCe ETITTaTor
SEGGER J-Link Emulator
Spectrum Digital XDS560V2 STM LAN Emulator
Spectrum Digital XDS560V2 STM TRAVELER Emulator
Spectrum Digital XDS560V2 STM USB Emulator
Spectrum Digital XDSPRO LAN Emulator
Spectrum Digital XDSPRO USB Emulator
Texas Instruments XDS100v2 USB Debug Probe
Texas Instruments XDS100v3 USE Debug Probe
I | Texas Instruments XDS110 USB Debug Probe |
Texas Instruments XDS2xx LAN Debug Probe
Texas Instruments XD$2xx USB Debug Probe

Texas Instruments XDS2xx USB Onboard Debug Probe -

ok -

4.7.2. Programming

1. Select “Program” item.
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\I Program

Settings & Utilities
Memory

Standalone Command Line

2. Select the image file prepared for programming. By default, the image file is located in the Release/Debug
folder within the project folder in the workspace.

Flash Image(s)

collector_LP_CC2652R7_tirtos7_ticlang.out Size: 1.45 MB | Binary: [ 4

~

3. Click the “Load Image” button to begin programming.

Available Action(s) - 1 Image Selected

Load Image Verify Image

4. When programming is successful, the console will display the following information.

[SUCCESS] Program Load completed successfully.

Please refer to the UniFlash quick start guide for more information about the UniFlash tool. Click the “Help” icon

to open the quick start guide.
@ Help L Settings

4.8. SmartRF™ Studio

SmartRF™ Studio is a Windows application that helps developers to easily evaluate the radio for all TI CC1xxx and
CC2xxx low-power RF devices.

This tool can also be used for RF certification testing.

Visit the link below to download and install SmartRF™ Studio.
https://www.ti.com/tool/SMARTRFTM-STUDIO

CALCULATION TOOL Download options

SMARTRF-STUDIO-7 — SmartRF Studio 7 application software & Notifications

Supported products & hardware

If the installer becomes locked during the download process, follow the instructions provided by TI.
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@ smartritm_studio-2.32.0.zip — 73596 K

4.8.1. Connect to the Module

1.
2.
3.

1.
2.

3.

Connect the module to the PC using the XDS debug probe.
Open SmartRF Studio 7.
SmartRF Studio will show that one 2.4 GHz device is connected.

mart ™ Studio7

2.4 GHz {1 Connected)

Sub-1GHz

CC2674R10 CC2674P10 CC2652PT CC2651R3

2.4 GHz 2.4
[ = MC

Double-click the ‘CC2652R7’ item.

Select the mode you want; in this example, the ‘BLE mode’ is selected.
Select CC2652RT mode
O BLE mode

@ [EEE 302.15.4 mode

@ Proprietary mode

After clicking OK, SmartRF Studio will open a new window called “Device Control Panel”.
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L8 XDs-XDS00092 - CC2652R7_BLE - Device Contral Panel - m} x

File Settings View Evaluation Board Help

Packet TX P start B siop [ command View [ RF Parameters

Target Configuration

RF Design Based On @ DC/DC Enable [] cap-array Tuning @

Typical Settings

+ Settings for Bluetooth Low Energy
BLE, 1 Mbps, LE 1M
BLE, 1 Mbps, BT4
BLE, 2 Mbps, LE 2M
BLE, 500 kbps, LE Coded

RF Parameters ﬁ
TX Power
17 - |[ 2240 | Mz [ whitening dam

Continuous T | Continuous R | Packet TX | packet Rx

PacketCount: | 100 |[] Infinite PDU Payload length:

Non-connectable advertising event.

Preamble Access Address || PDU Header Adv Address Adv. Data

01010101... |||[e=][22][be][e]||[ 07 1e_ | |[09 ][os |[ 010202040505 |[babe | {|[sn [oase 6098 298 45 47.2¢ 0Faz 34 ca ot 1

Add Seq. Number

® Random | na 52 69 99 £295 45 47 22 0183 34 c5 a4 fa 2027 14
O Text
O Hex ™
Sent Packets:
Channel:
Output Power:

Start

‘CC2652RT_BLE, Rev. B (1.1), XDS-XDS00092 XDS10 Radio State: N.A.

4.8.2. Change the Default Settings

1. Do not enable ‘Cap-array Tuning’.
Target Configuration

RF Design Based On: @ DC/DC Enable [] caparray Tuning &

2. Select the PHY setting.

Typical Settings

= Settings for Bluetooth Low Energy
BLE, 1 Mbps, BT4
BLE, 2 Mbps, LE 2
BLE, 500 kbps, LE Coded
BLE, 125 kbps, LE Coded

3. Select the ‘BLE Channel’ or ‘Frequency’ and ‘TX Power".

RF Parameters ﬁ

17 ~|[2440 | MHz Whitening & dBm
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4.8.3. Perform RF Test

RF testing is divided into continuous TX/RX and packet TX/RX. The signal duty cycle is 100% when operating in
continuous mode. The following steps use continuous TX as an example to demonstrate how to start the RF test.

1. Click “Continuous TX".
I CnntinuuusT}(l Continuous R | Packet TX | Packet X .

2. Enable or disable modulation of the transmitted signal. When the “Unmodulated” radio box is selected, the

signal is a carrier wave.

() Modulated (®) Unmodulated

3. Click “Start” to start transmitting the RF signal.

Output Power: 20 dBm
Channel: o

[

Please refer to the help document for more information about the SmartRF Studio tool. Click icon EZE to open

the “SmartRF Studio Help” window, then click the “Browse Complete Help Document:++” button to access the
help document.
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&l SmartRF Studio Help

Help

The SmartRF Studio Startup Window shows an

overview of all available RF devices and
indicates which of them are physically
connected.

Right click on the device icon to access
additional infermation about the device.

Double click on the device icon to start Device
Control Panel for the RF Device.

If wou have any questions or want to give
feedback on SmartRF Studio, please visit
support.ti.com.

Browse Complete Help Document...

Revizion History...

Distribution and Disclaimer...

Check for Updates...

Close

4.0ther Resources

About SmartRF Studio
SmartRF Studio 2.30.0 jbuiks2s7)

SmartRF Studio is a tool that lets
customers evaluate, test and configure
Low Power RF devices from Texas
Instruments. It iz in particular useful for
generating chip specific register values

and for finding and tuning RF parameters.

This software iz developed by Texas
Instruments to the courtesy of our
customers.

SmartRF Studio will not target Automotive
customers since it is not gualified for
Automotive devices. Customers may use
SmartRF Studie 7 for autometive devices,
but it is the customer's responsibility to
ultimatety comphy with regulatory
requirements.

Copyright (c) Texas Instruments

Access more documents by visiting the TI CC2652R7 page at the link below.
https://www.ti.com/product/CC2652R7

Additionally, refer to the guides for different components for more information about the Simplelink SDK. The

guides are located in the directory below:

C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\docs

For other related documentations of the module, please visit the module product page at bdecomm.com.

5. O0rdering Information

Table 3. Ordering Information

Product Type

Orderable Part Number

Description

Evaluation Kit

BDE-MP2652R7xx-K1

Evaluation kit 1 for module BDE-MP2652R7xx, includes 1x
BDE-MB13-BO, 1x BDE-LPEM, 1x BDE-XDS110, 1x USB
type C cable. Refer to module datasheet for module
variants. For example, BDE-MP2652R7A0 -K1 is the
evaluation kit 1 for module BDE-MP2652R7A0
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Product Type Orderable Part Number Description

Module Breakout Board BDE-MB13-BO Breakout board with BDE-MP2652R7xx module

Interface Evaluation Module | BDE-LPEM Launchpad evaluation module with BoosterPack interface
Debugger BDE-XDS110 XDS110 debugger

6. Revision History

Table 4. Revision History

Revision

Date

Description

V1.0

2025-4-16

First release

7. Additional Information

7.1. Trademarks

Bluetootheis a registered trademark of Bluetooth SIG, Inc.

Launchpad™ is a registered trademark of Texas Instruments.

BoosterPack™ is a registered trademark of Texas Instruments.

SmartRF™ is a registered trademark of Texas Instruments.

All trademarks are the property of their respective owners.
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Important Notice and Disclaimer

The information contained herein is believed to be reliable. BDE makes no warranties regarding the information
contain herein. BDE assumes no responsibility or liability whatsoever for any of the information contained herein.
BDE assumes no responsibility or liability whatsoever for the use of the information contained herein. The
information contained herein is provided "AS IS, WHERE IS" and with all faults, and the entire risk associated with
such information is entirely with the user. All information contained herein is subject to change without notice.
Customers should obtain and verify the latest relevant information before placing orders for BDE products. The
information contained herein or any use of such information does not grant, explicitly or implicitly, to any party
any patent rights, licenses, or any other intellectual property rights, whether with regard to such information
itself or anything described by such information.

Contact
BDE Technology Inc.

USA: 67 E Madison St, # 1603A, Chicago, IL 60603, US
Tel: +1-312-379-9589

China: B2-403, 162 Science Avenue, Huangpu District, Guangzhou 510663, China
Tel: +86-20-28065335

Website: www.bdecomm.com Email: info@bdecomm.com

BDE Technology Inc. 41/ ¢ info@bdecomm.com
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